POLICY STATEMENT

An orderly, defined system of written directives is an integral part of an organization's ability to communicate effectively with its employees and others to whom information is being conveyed.

The Chief of Police has the ultimate authority to issue, modify, and approve all departmental written directives. In specific situations, which are identified in this policy, the Chief's designee has the authority to issue, modify, and approve written directives.

The purpose of this General Order is to formally define and institutionalize the Department Written Directive System existing within the Dayton Police Department.

I. MANUAL OF PROCEDURE


B. Each sworn member of the Department will be issued a Manual of Procedure while in the Academy. The Manual of Procedure is owned by the City of Dayton, the Manual must be returned upon discontinuing employment with the police department. Officers are not required to maintain their own Manual of Procedure but they are responsible for knowledge of its contents. All General Orders are posted on the PowerDMS site.

II. INFORMATION AND PROCEDURE GUIDE FOR NON-SWORN EMPLOYEES

A. The Information and Procedure Guide for Non-Sworn Employees will consist of one binder.

B. The organization of the Information and Procedure Guide is as follows: Cover sheet, introduction, preface, Table of Contents, General Orders pertaining to non-sworn employees, and Rules of Conduct for Non-Sworn Personnel.

C. The Information and Procedure Guide for Non-Sworn Employees is owned by the City of Dayton, the Guide must be returned upon discontinuing employment with the police department. Personnel are not required to maintain their own Information and Procedure Guide for Non-Sworn Employees but they are responsible for knowledge of its contents. All General Orders are posted on the PowerDMS site.

III. WRITTEN DIRECTIVES

A. GENERAL ORDERS

1. Purpose of General Orders
   a. General Orders formalize new or revised departmental policy and procedure.
   b. The subject matter of General Orders includes, but is not limited to, the institution of permanent procedures, policies, and relationships with other agencies and citizens.

2. Distribution and Numbering of General Orders
   a. General Orders will be numbered by section and will be indexed and cross-referenced by the Policy and Research Unit.
b. General Orders are distributed in PowerDMS to all Police Department personnel by the Policy and Research Unit placed on the PowerDMS.

c. All employees will be required to check PowerDMS at least once per duty day. All personnel will be held accountable for reading the orders as they are posted. It will not be a defense for violating policy in that the employee did not read or sign for an order.

d. The supervisor of each work unit will provide roll call training of policy revisions as they are posted.

e. General Orders are issued by the Chief of Police and may be used in a disciplinary proceeding; a signed original order will be kept on file in the Policy and Research Unit.

f. All personnel will be responsible for the information contained in the Manual of Procedure and/or Information Guide and shall review the policy revisions as they are posted.

g. General Orders are effective on the date of their distribution unless indicated otherwise.

h. On the date of its distribution, a General Order supersedes all other orders, memorandums, or directives, of any kind, which were issued prior to the distribution of the General Order.

3. Review of General Orders

All new General Orders will be reviewed by all members of the Executive Command Staff, all Lieutenants and the Policy Review Committee, prior to their creation and dissemination. The Policy and Research Unit will review all General Orders yearly.

B. EXECUTIVE ORDERS

1. Executive Orders implement emergency or special procedures or policy when time does not permit the distribution of new or revised General Orders. An Executive Order can supersede part, or all, of a General Order, which was distributed prior to the issuance of the Executive Order. Executive Orders only supersede the part(s) of General Orders, which the Executive Orders are germane to. Executive Orders should contain information, which will eventually be placed in the Manual of Procedure. Executive Orders will be numbered consecutively with a suffix consisting of the last two digits of the year; i.e., 1-2001, 2-2001, 3-2001, etc.

2. The subject matter of Executive Orders includes, but is not limited to, changes in Rules and Regulations, policy, procedures, realignment of units within the department, and legal decisions or major changes in law, which will result in a substantial change in procedure.

3. Executive Orders are distributed by the Policy and Research Unit. Any Division, Bureau, or Unit, which desires to have an Executive Order distributed, will submit it to the Policy and Research Unit via e-mail for review and issuance of a number. The Policy and Research Unit will submit the final version to the Chief, or their designee, for signature.

4. Executive Orders will be distributed in PowerDMS. All employees will be required to check their PowerDMS accounts at least once per duty day. All personnel will be held accountable for reading the orders as they are posted. It will not be a defense for violating policy in that the employee did not read or sign for an order. Supervisors will be responsible for reviewing Executive Orders at roll call.

5. Executive Orders will be reviewed yearly by the Policy and Research Unit to determine if they should be canceled, continued, or included in a General Order or the Rules of Conduct.

6. Executive Orders are issued by the Chief of Police, or their designee, and may be used in disciplinary proceedings.

C. ADMINISTRATIVE MEMORANDUMS

1. Administrative Memorandums contain general information of a short-term nature and changes in policy or procedure that will not be placed in a General Order. Administrative Memorandums will be numbered consecutively; i.e., 001, 002, 003, 004, etc. for each calendar year.
2. The subject matter of Administrative Memorandums includes, but is not limited to, the announcement of police sponsored events, public events, meetings, award and promotion ceremonies, telephone number changes, changes in form reports, and the distribution, deletion, or alteration of General Orders.

3. Administrative Memorandums are distributed by the Policy and Research Unit. Any Division, Bureau, or Unit, which needs to have an Administrative Memorandum distributed, will submit it to the Policy and Research Unit via e-mail for review and issuance of a number. The Policy and Research Unit will number the order and submit the final version to the Chief, or their designee, for signature.

4. Administrative Memorandums will be distributed in PowerDMS. All employees will be required to check their PowerDMS accounts at least once per duty day. All personnel will be held accountable for reading the orders as they are posted. It will not be a defense for violating policy in that the employee did not read or sign for an order. Supervisors will be responsible for reviewing Administrative Memorandums at roll call.

5. Administrative Memorandums are signed by the Chief of Police or their designee, and may be used in disciplinary proceedings.

D. SPECIAL ORDERS

1. Special Orders formalize appointments, promotions, reassignments, transfers, retirements and training assignments. Special Orders have a date of issuance but are not numbered.

2. Personnel Transfers:
   a. Transfers within a Division – A copy will be sent to the affected Division Commander, Bureau/Unit Commanders and Police Payroll. A signed copy will be e-mailed to Policy and Research for dissemination via e-mail to department personnel.
   b. Transfers between Divisions – will be routed through the chain of command to the Chief of Police for Signature and will be disseminated via e-mail by Policy and Research to department personnel.
   c. Changes in work assignment are to be prepared by the supervisor of the employee’s NEW work unit via a Special Order reflecting the change in assignment. The Special Order must be submitted at least five (5) business days prior to the effective date of the reassignment. Changes in assignment are only effective when the appropriate supervisor (Division Commander for Division transfers and Chief of Police for all others) has reviewed and approved the Special Order authorizing the reassignment. All transfer special orders must be formatted as in Attachment B.
   d. An accurate listing of current ASN numbers will be maintained by the Administrator of the M.I.S. system, who will review any request to create a new ASN. ASN numbers of all personnel will also be published in the quarterly Police Detail, produced in the Office of the Assistant Chief.

3. All other Special Orders will be prepared by Police Personnel or Division Commanders. Special Orders are distributed via E-mail. Copies of all Special Orders will be retained in PowerDMS for future reference.

4. Special Orders are signed by the Chief of Police, or their designee, and may be used in a disciplinary hearing.

5. The Policy and Research Unit will be the central repository for documents that are sent to officers via PowerDMS or E-mail:
   - Training Bulletins – will be prepared by academy staff or Policy and Research. Once approved, they will be distributed via PowerDMS and stored in the Training Bulletin Folder in PowerDMS.
   - Special Orders – will be prepared by the originating unit/division with the final approved versions sent to Policy and Research to be distributed via e-mail and stored on PowerDMS. The original hard copy will be stored in the Chief’s office book and a signed copy returned to Police Payroll. Transfer special orders will be prepared as listed above.
• Job Postings – will be prepared by the requesting unit and once approved will be forwarded to Policy and Research to be distributed via e-mail and stored on.

E. DIVISIONAL ORDERS

1. The subject matter of Divisional Orders is limited to policy, procedures, and rules or regulations, which affect only the employees of a particular division. Divisional Orders will be numbered consecutively with a prefix consisting of the last two digits of the year; i.e., 01-001, 01-002, 01-003, etc.

2. Divisional Orders are issued under a Division Commander's signature and may be used in a disciplinary proceeding. Such orders will not be in conflict with an existing policy unless permission is obtained, in writing, from the Chief of Police.

3. Divisional Orders will be reviewed yearly by the Division Commander.

F. SPECIAL REPORT

1. A Special Report may address a variety of subjects: written and oral reprimands, transfer requests, and specific incidents where an immediate report is necessary. Special Reports can be the basis for a direct order or assignment of work, or can emphasize portions of previously issued orders.

2. A Special Report can be prepared and submitted by any departmental member.

   • A Special Report flows from subordinate to supervisor or from supervisor to subordinate.

3. A Special Report may be used in a disciplinary proceeding.

4. All Special Reports should be formatted as noted in Attachment C.

G. TRAINING BULLETINS

1. Training Bulletins serve to alert officers to information which will assist them in the performance of their duties and advise officers of changes in law which will not result in a change in policy or substantial change in procedure. Training Bulletins will be numbered consecutively with a prefix consisting of the last two digits of the year; i.e. 01-1, 01-2, 01-3, etc.

2. Training Bulletins will be prepared by academy staff or Policy and Research after the Chief of Police or their designee has approved the topic matter.

3. Training Bulletins will be distributed via PowerDMS and stored in the Training Bulletin Folder on PowerDMS. All personnel will be held accountable for reading training bulletins as they are posted. Unit Supervisors will be responsible for reviewing and discussing the training bulletin during roll call. They will be stored electronically in PowerDMS.

4. Training Bulletins may be used in disciplinary proceedings.

5. New Training Bulletins will be reviewed by the Investigations - Administrative Support Division Commander prior to their issuance. The Commander of the Training Bureau will review existing Training Bulletins yearly.

H. RULES OF CONDUCT

1. The Rules of Conduct governing all sworn employees of the Dayton Police Department are located in the last section of the Manual of Procedure. Rules of Conduct will be organized by Chapters and numbered consecutively.


3. Rules of Conduct may be used in disciplinary hearings.
4. All new Rules of Conduct will be reviewed by all members of the Executive Command Staff, all Lieutenants, and the Policy Review Committee, prior to their creation and dissemination. The Policy and Research Unit will review existing Rules of Conduct yearly.

I. MISCELLANEOUS MEMORANDUMS

1. A miscellaneous memorandum is used to communicate a wide variety of subject matter. Miscellaneous memorandums will carry a date of issuance, but will not be numbered.

2. A miscellaneous memorandum is used to convey information between Divisions, Bureaus, Reliefs, and individuals.

3. A miscellaneous memorandum may be used as documentation that an employee has been retrained on a specific policy or procedure.

4. A miscellaneous memorandum can appear in numerous formats and can be typed or handwritten.

5. A miscellaneous memorandum can flow from superior to subordinate, or from subordinate to superior.

6. A miscellaneous memorandum is a form of communication that serves many purposes and may be used in a disciplinary hearing.

J. STANDARD OPERATING PROCEDURE MANUALS FOR DIVISIONS, BUREAUS AND UNITS

1. The purpose of Standard Operational Procedure (SOP) manuals is to provide personnel assigned to specialized tasks, with a reference manual that can be utilized on a daily basis. SOP manuals are developed and maintained at the affected unit, bureau, or division. Information that is not useful to the majority of personnel will not be placed in a General Order. It will be placed in Division, Bureau, or Unit manuals.

2. The SOP will assist the officer in the performance of their duties and ensure that service is rendered in compliance with established procedures, policies, and goals of the Dayton Police Department.

3. The material contained within the SOP requires the written approval of the appropriate Division Commander and the Chief of Police. Any addition or deletions to the manual must be sent to the Policy and Research Unit via e-mail for inclusion into the electronically stored SOP and will require the Chief's knowledge and written approval. It is the responsibility of Division Commanders and Bureau Commanders to ensure SOP manuals used by personnel under their command are updated as necessary (The Policy and Research Unit will maintain an electronically stored version of the SOP once created). SOP manuals may be used in disciplinary proceedings.

K. Incident Logs

1. All serious incidents or any incident that needs to be brought to the attention of Command Staff, will be documented in an incident log.

   a. Some incidents that should be documented include, but are not limited to:

      (1) Injuries to officers.
      (2) Shootings
      (3) Stabbings/cuttings
      (4) Civil disturbances
      (5) Strikes
      (6) Response to Resistance/Aggression
      (7) Incidents involving NOTED persons
      (8) Cruiser accidents
      (9) Call-outs of specialized or investigative units
      (10) Pursuits (including incidents from other jurisdictions that terminate without our involvement)
      (11) Shooting into Habitations
      (12) Aggravated robberies related to a bank or commercial establishment
This General Order supersedes all prior rules, regulations, policies and procedures, whether oral, written or by previous practice.

General Order 1.01

Written Directives System and Specialized Reports

(13) Aggravated burglaries
(14) Any search warrant served on a business or residence
(15) Crimes that would draw media attention.
(16) All deaths related to a crime, overdose or involving a child (adult natural deaths are not included)

b. Incidents or problems of a very sensitive nature or officer and/or City official misconduct are not to be placed in an incident log. Keep in mind that incident logs are a public record.

c. Incident logs should include the victim and suspects name, race, and age. If the crime is of sensitive nature, such as rapes or crimes where a child is a victim, their name should be excluded from the Incident Log.

2. Incident logs will be completed during a patrol supervisor's tour of duty.

3. Unit supervisors will also create an incident log when necessary.

4. Incident logs will be distributed as follows:

   a. Create the incident log in e-mail or as an attachment.

   b. Once in E-mail, the log will be addressed to DPD – Incident Log

L. L.E.A.D.S. Newsletters

1. All personnel that are certified to utilize the LEADS system are required to read the e-mail sent out by the L.E.A.D.S. TAC or their designee and indicate that they have read the quarterly newsletter. The newsletter will be sent out via PowerDMS and stored in the LEADS Folder on the PowerDMS

2. L.E.A.D.S. requires that all operators read the newsletter to maintain their certification. The newsletter contains informative articles covering a variety of subjects pertinent to the operation and usage of the L.E.A.D.S. system.

M. Miscellaneous Correspondence/ Requests to other Departments/ Outside Agencies (See General Order 1.09-1 Public Information and News Release, Section III.A & Section IV.

1. All written requests, special reports, memos, letters, etc generated by departmental personnel must be routed through the chain of command to the Chief of Police prior to going to the other City Department/outside agency/individual.

2. This does not include standard follow-up letters to victims of crime or similar correspondence, minor copying requests to city reproduction or other day-to-day requests to other city departments.

N. S-96 Employee Weekly Time Records

Officers and sergeants who do not normally go on duty via radio and MDT (i.e. Operations Divisions) are required to document their meal breaks by completing an S-96 Employee Weekly Time Record “Green Sheet” to document this information.

The time records are to be completed on a weekly basis and submitted to the employee's immediate supervisor, who will store them, on-site for a period of 2 years.

IV. Electronic Mail

A. Only legitimate law enforcement or job-related communications will be sent/relayed/downloaded through the Communications System of the Dayton Police Department or any Department owned computer.

1. Employees must read their e-mail accounts on a daily basis while on duty and respond when necessary.
2. Employees are prohibited from sending mass e-mail to all other users through the use of “zz.All Users” address group or any other mass group unless authorized by their Superintendent.

3. Personnel wishing to advise a judge, magistrate or hearing officer of additional unsolicited information pertinent to a case they might be hearing or which is relevant to the jurisdiction of the court may do so through their Division/Bureau/Watch Commander. Personnel can e-mail or send the information to the Division/Bureau commander for review, after which, that supervisor will determine if it is appropriate to forward on to the intended recipient.

4. The expectation of employee privacy does not extend to an employee’s work-related conduct or use of government-owned equipment and supplies; this includes e-mail and Internet usage.

B. Violations of these provisions will be subject to the disciplinary process.

V. PowerDMS

PowerDMS is an on-line document management system. General Orders, Executive Orders, Administrative Memorandums, Training Bulletins, etc. will be posted to the website. All personnel will have access to the site via the internet or phone app. Employees will receive a notification via City E-mail that a document has been posted and will be required to view the documents(s).

All employees will be required to check their PowerDMS accounts at least once per duty day. PowerDMS is composed of four software modules:

- POLICY- allows employees to view policies online and handle their electronic document signatures, ensuring Receipt of Written Directives.
- TRAINING - offers employees on-line training. The academy will be mostly responsible for administering this aspect of PowerDMS.
- TEST - will assess personnel knowledge on important general orders and policies as well as training.
- SURVEY - provides a tool for the Command Staff and Supervisors to give personnel a way to share their opinions and feedback regarding their positions.

VI. Required Signatures

Certain documents require an employee’s signature, the following list are those that an employee is required to sign. All signatures on any reports must be signed in BLUE ink.

A. Specifications and Charges.
B. Discipline – oral and written reprimands.
C. Training Memorandums.
D. S-93.
E. Internal Investigation Reports, F-563.
F. Special Reports.
G. Injury Investigations.
H. Polygraph testing authorization form.
I. Random drug testing authorization forms.
J. Internal Affairs order-in form.
K. Court subpoenas/order-ins.
L. Any forms required in the performance of official duties (i.e. traffic citations, parking citations, etc.).
M. Any other forms/reports/documents when ordered to sign by a supervisor.
Attachment A

Routing of Reports - the following will apply to all reports sent to the Chief’s Office:

**Administrative Investigations** – See BlueTeam investigations in G. O. 2.04-10.

**City Vehicle Accidents** - original and 1 copy (copy to the M.V.C.)

**Citizen Complaint Response Letter** - original and 1 electronic copy (original to citizen, copy placed in BlueTeam) this will be on DPD letterhead and will include an addressed envelope and all pertinent appeals forms. If the complaint recommended discipline greater than a Written Reprimand, the letter will be for the Chief’s signature with no date.

If there is no discipline recommended or discipline up to a Written Reprimand, the letter will be for the Division Commander’s signature and will be dated for 3 business days from the date the letter is submitted from the bureau.

**Employee Counseling Form** – original and 1 Copy (copy will go to the employee and the original will go to the employee’s work unit after being served upon the employee.) The original will be retained in the work unit for (2) years after the date of issuance. The Department Advocate gets original ECF’s for violations of ROC 3.11 only.

**Response to City Manager** – original and 1 copy of all documents (original to CM, copy to Chief’s file) Chief’s signature on City Manager’s Memo format with a CC: Joe Parlette, Deputy City Manager and Tammi Clements, Assistant City Manager.

**Commendations** - original on parchment (copies will be made after signatures; original to employee, copies to: Personnel, Department Advocate, and Awards board).

**Injury Reports** - original and 1 copy of all documents (original to Human Resources, copy to personnel)

**Moral Obligation** - original and 1 copy of all documents (original to Law Department, copy to Chief’s file)

**Off Duty Employment** - original and 1 copy (original to personnel, copy back to employee)

**Reprimands** - 2 originals (both with original signatures; original to employee, other original to Department Advocate after being served)

**Special Orders** - original and 1 copy (clean original for Chief’s signature, copy for Division Commander’s initials if transferring between divisions/ 1 original only if transferring within division)

**Training Memorandum** - original and 1 copy (original to employee, copy to department advocate)

All special reports, resignation forms or other reports not listed should be submitted as ORIGINALS ONLY. Charges and Specifications, Findings, Grievances, etc. should be distributed according to policy after service.

**Format of Letters and Memos** – When typing letters or memos to be signed by any of the command staff, include their initials along with the initials of the person typing the letter (e.g., RSB:xxx). This will document who authored the correspondence. Additionally if there are any attachments or enclosures ensure that it is documented at the end of the correspondence.

**Signatures** – Signatures on all reports must be legible or the name printed/typed under the signature.
Attachment B – Transfer Special Order Format

Month Date, Year

~2 blank lines between Date and ALL CAPS~
SPECIAL ORDER

~1 blank line between SPECIAL ORDER and COMMANDERS~
COMMANDERS – DIVISIONS AND BUREAUS

~2 blank lines between ALL CAPS and header~
The following assignment (or temporary assignment) will take effect Month Date, Year:

~2 blank lines between header and employee~
(This example is a complete change of all information)
Rank First M. Last, PDA ####, FROM Name of Division, Name of Bureau or Unit or Relief, old pay rule #, old ASN ###, old crew number ###, old letter day off #, old telephone number ####-#### TO Name of Division, Name of Bureau or Unit or Relief, new pay rule #, new ASN ###, new crew number ###, new day off code #, new telephone number ####-####.

~1 blank line between employees~
(This example is a partial change of information – new relief)
Rank First M. Last, PDA ####, FROM Name of Division, Name of Bureau or Unit or Relief, pay rule #, old ASN ###, old crew number ###, letter day off #, telephone number ####-#### TO Name of Division, Name of Bureau or Unit or Relief, new ASN ###, new crew number ###. Pay rule, letter day off and telephone number remain the same.

~4 blank lines~
Authorized Name
Position Title

~2 blank lines~
XXX:xxx

~~Font is Times New Roman 12
~~Paragraphs are justified with single spacing
~~Page margins are 1” on top, bottom and sides
~~Page numbers are required if the order is more than one page (Proper format is bottom of page, Bold Numbers 2 selection)
Attachment C – Special Report Format

Date (July 4, 2017, not July 04, 2017 or 7/4/17)

4 blank lines

TO: Rank Name N. Name
Division (Always first), Title/Position/Unit/Squad/Relief

2 blank lines

FROM: Rank Name N. Name
Division (Always first), Title/Position/Unit/Squad/Relief

2 blank lines

**SUBJECT:** In Bold Type Align the word SUBJECT with the Rank and Division from above

2 blank lines

Salutation:

1 blank line

This document is a template for special reports. Pay attention to the alignment, punctuation, bold and underlined items in this document, as well as the below listed formatting points.

- Use “Times New Roman” 11 or 12 point font.
- Spacing is Single Spacing.
- The body of the report is to use the justify feature in the Paragraph box beside the Font box on the Home tab.
- Use one inch margins on the document by clicking the Page Layout tab.
- Any special report exceeding 1 page must have page numbers in the lower center of each page. To insert them, click the Insert tab, click Page Number, highlight Bottom of Page and select Bold Numbers 2.

Common error examples are:

- Using “14:30 hours” instead of “1430 hours”
- Using Squad numbers in Patrol Operations – Refer to them as Reliefs
- Abbreviating anything that is typed such as “St.” instead of “street” or “P.O.” instead of “Officer” (The exception is the signed title on the signature line)
- Using the previous district names instead of current names (Use West Patrol Operations Division-South as opposed to 3rd District)
- Overlooked spelling issues.

Errors in spelling or formatting should be returned to the author prior to being forwarded to the next level in the chain of command. This is now the end of the body.

2 blank lines

Respectfully submitted,

4 blank lines

Rank Name (including middle initial) PDA/ASN